
CAD Representative Handbook 

Document Number: CR-XRL-Z3-GUI-CR001-50480 

Document History: 

Version: Date: Prepared by: Checked by: Authorised by: Reason for Revision: 

1.0 10.11.15    First Release 

2.0 12.01.16    Inclusion of web-based User 
Management Tool 

This document contains proprietary information.  No part of this document may be reproduced without prior 
written consent from the chief executive of Crossrail Ltd.

Le
arn

ing
 Le

ga
cy

 D
oc

um
en

t

Brigid Leworthy
Typewritten Text

Brigid Leworthy
Typewritten Text
This document is shared for the purposes of learning legacy. It is a snapshot in time and hence many of the links within the document will become obsolete over time. Some links/document references will refer to a document storage location that isn't accessible. Users should refer to the learning legacy website where these documents may be published separately.

Brigid Leworthy
Typewritten Text

Brigid Leworthy
Typewritten Text



 

 

 

 

 

Contents 
1 Foreword .......................................................................................................................... 1 

Relationships with other Documents:..................................................................................... 1 

1.1 Use of this Document:....................................................................................................... 1 

1.2 Presentation Conventions: ................................................................................................ 1 

2 Scope ................................................................................................................................ 2 

2.1 General Information ......................................................................................................... 2 

3 Access to the CRL ECMS ..................................................................................................... 3 

3.1 Accessing CRL ECMS .......................................................................................................... 3 

3.2 Logging in to CRL ECMS ..................................................................................................... 3 

4 CRL ECMS Client Software (CRL ProjectWise Explorer) ........................................................ 5 

4.1 CRL ProjectWise Explorer window ..................................................................................... 5 

4.2 Viewing Models & Drawings – Toolbars ............................................................................. 6 

4.3 Quick Search in the CRL ECMS ........................................................................................... 7 

4.4 Advanced Searching in the CRL ECMS ................................................................................ 9 

5 Permissions in the CRL ECMS (ProjectWise) ..................................................................... 12 

5.1 CRL User Management tool ............................................................................................. 12 

5.2 CRL ECMS User Groups .................................................................................................... 14 

6 Third Party Data .............................................................................................................. 15 

7.1 Creating Single Documents in the CRL ECMS .................................................................... 19 

7.2 Creating Multiple Documents .......................................................................................... 28 

8 Reinforcing Schedules – Upload to the CRL EDMS (eB) ..................................................... 29 

9 Creating a Document Set in the CRL ECMS ....................................................................... 33 

10 Superseding or Cancelling CAD Drawings and Models in the CRL ECMS ............................ 36 

11 Deleting documents in the CRL ECMS ............................................................................... 42 

12 CRL ECMS Workflows ...................................................................................................... 43 

13 CAD QA inside the CRL ECMS ........................................................................................... 47 

13.1 Guide to the CAD QA Rules ............................................................................................. 48 

14 MicroStation Standalone CAD QA .................................................................................... 51 

15 Publishing documents in the CRL ECMS ............................................................................ 54 

16 Additional Resources ....................................................................................................... 55 

16.1 Crossrail-Bentley Information Academy (CBIA) ........................................................... 55 

17 Contacts .......................................................................................................................... 57 

Le
arn

ing
 Le

ga
cy

 D
oc

um
en

t



 

 

 

 

17.1 Contacting CAD Services ............................................................................................ 57 

17.2 Contacting the Crossrail IT Service Desk ..................................................................... 57 

18 Glossary .......................................................................................................................... 58 

19 Table of Figures ............................................................................................................... 60 

20 Table of Tables ................................................................................................................ 63 

 

Le
arn

ing
 Le

ga
cy

 D
oc

um
en

t



A Practical Guide - Foreword 

 

Page 1 of 63 

Document uncontrolled once printed.  All controlled documents are saved on the CRL Document System 

   © Crossrail Limited  RESTRICTED 

 

1 Foreword 

Relationships with other Documents: 

This document may be used in conjunction with: 

• CRL Works Information Vol. 2B (various sections) 
• CRL CAD standards (CRL1-XRL-O6-STD-CR001-00014) 

1.1 Use of this Document: 

This document has been produced as a reference guide for CRL Contractor CAD representatives and as 
such provides advice and guidance on all duties pertaining to that role. The document has been broken 
into numbered sections to assist the user when referring to or discussing content with CAD Services or 
others.  This document does not constitute an instruction. For the avoidance of doubt all parties should 
refer to their relevant Works Information for the Employers Requirements applicable to their scope of 
Works. 

1.2 Presentation Conventions: 

Where useful information or hints are shown, they shall be expressed in blue italics as 
illustrated in this figure. 

This document has been written as addressed to the user. 
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2 Scope 

2.1 General Information 

The CRL ECMS, ProjectWise stores and manages all CAD data used on the Crossrail Project. Contained 
within these CAD files combined is the virtual representation and single source of truth for the design 
for Crossrail. In the future it may also contain a similar ‘As Built’ representation or ‘Asset Model’ of what 
has been installed for use in operations and maintenance by Information Maintainers (IMs). 

 

This document is intended as a reference guide for CRL Contractor CAD representatives. Its content 
describes the CRL Electronic CAD Management System (ECMS), its workflows, users and associated 
processes and procedures.  
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3 Access to the CRL ECMS 

This document requires that you have a CRL ECMS user account. If not, please submit a service request 
to Crossrail IT through either the Service Connect page on the Crossrail Intranet or through your Site 
Team Administrator. 

 

3.1 Accessing CRL ECMS  

CRL ECMS is established through the CRL Citrix connection. Further information related to Citrix 
connectivity or troubleshooting a Citrix connection is provided by the Crossrail IT Service Desk. The IT 
Service Desk can be contacted using either of the following methods: 

By email -  

By phone -  

 

3.2 Logging in to CRL ECMS 

Open CRL ProjectWise.exe, this is normally located in the following location 

For Windows 7: 

Start > All Programs > Bentley > ProjectWise V8i (Select Series 2) > ProjectWise Explorer 

 

If the CRL ECMS client is not located in the above locations, please contact either the Crossrail 
IT Service Desk (if installed by Crossrail) or your own IT Department (if installed by your own 
IT Department). 

Click on the ‘+’ symbol next to CRL Production 1 or CRL Production 2 to prompt the ProjectWise 
Explorer Log in box to appear. See Figure 3-a ProjectWise Explorer Datasources. 

 

Figure 3-a ProjectWise Explorer Datasources 

 

There is no difference between logging into CRL Production 1 and CRL Production 2. The 
number at the end refers only to a gateway into the datasource.
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If you are using a Crossrail account and a Crossrail provided PC which is connected to the Crossrail 
Network directly, the ECMS client software will automatically proceed to connect and authenticate you. 

 

If you are accessing the CRL ECMS through Citrix, please enter your Crossrail User Name (preceded by 
CRLAD\) then password and click the Log in button. 

 

 

Figure 3-b ProjectWise Explorer Log in 

 

If you are accessing the CRL ECMS through Citrix, please ensure that the Use Windows Single 
Sign-On for authentication box is not selected. 

 

If the prompt in Figure 3-c Directory creation confirm dialog appears you should click Yes. 

 

 

Figure 3-c Directory creation confirm dialog 
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4 CRL ECMS Client Software (CRL ProjectWise Explorer) 

4.1 CRL ProjectWise Explorer window 

Figure 4-a CRL ProjectWise Explorer Window displays the structure of the CRL ECMS. The main application 
window is split into three key areas:  

 

 
Figure 4-a CRL ProjectWise Explorer Window 

 

Item Description 

Folder Explorer Column A folder structure allowing you to navigate through 
the CRL ECMS data repositories. 

Object Explorer Pane Displays items relating to the specified object that 
has been selected within the Folder Explorer 
Column. 

Properties/Details Pane Displays information relating to the specified object 
that has been selected within the Object Explorer 
pane. 

  

Approved files can now be viewed. If you require access to particular Unapproved files, you will 
need the relevant CRL ECMS permissions – See section 5 User Management tool for more 
information. 

Folder 

Explorer 

Object Explorer 

Properties/ Details  
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4.2 Viewing Models & Drawings – Toolbars 

The CRL ECMS layout is similar to Windows Explorer, and shares many of the same functions and features. 

At the top of the CRL ProjectWise application window, you will find a row of Toolbars, which can be used to 
provide quick access to functions that are commonly used. You can choose which toolbars you want to 
display yourself. Go to View > Toolbars > (check toolbars to be used).  The most common toolbars used on 
the Crossrail Project are; Standard, Navigation, View, Search, and Address - See Figure 4-b View Menus. 

 

 

Figure 4-b View menus 

 

Selecting toolbars through View > Toolbar allows you to add/remove toolbars to/from the CRL 
ProjectWise menu bar. 

 

Item Description 

Standard Creating and opening documents. 

Navigation Navigating back and forth through most recently 
used commands. 

View View options of files within the common folder 
structure area. 

 

It is recommended to have the viewer set to Default View when viewing files. 
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4.3 Quick Search in the CRL ECMS 

The Quick Search toolbar (Figure 4-c Quick Search Toolbar) allows you to search for specific drawings or 
models - wildcards can be used if the full drawing or model number is not known. Alternatively drawings can 
be accessed via the Common Folder Structure/ File Explorer. 

 

 

Figure 4-c Quick Search Toolbar 

 

If your search returns ‘no results’, you may want to check you are searching the whole datasource 
and not just the current folder and that you have ‘Show all versions’ turned on. Without ‘Show all 
versions’ turned on, your search will only retrieve results for the current version and not previous 
revisions. 

To turn on Show all versions: 

Tools > Options > Settings (tab) > expand Document list > tick on Show all versions > Apply > OK  

See Figure 4-d Settings – Show all versions dialog 

 

 

 

 

 

 

 

 

 

 

 

 

 

             Figure 4-d Settings – Show all versions dialog 

Le
arn

ing
 Le

ga
cy

 D
oc

um
en

t



A Practical Guide- CRL ECMS Client Software (CRL ProjectWise Explorer) 

 

Page 8 of 63 

Document uncontrolled once printed.  All controlled documents are saved on the CRL Document System 

   © Crossrail Limited    RESTRICTED 

 

To widen the scope of the search to include the whole datasource go to Search > Settings > select Search in 
datasource > OK 

See Figure 4-e and Figure 4-f for further guidance. 

 

 

 

    

.  

 

 

 

 

 

 

 

 

 

    Figure 4-e  Quick Search Toolbar settings 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  Figure 4-f  Quick Search settings dialog 
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4.4 Advanced Searching in the CRL ECMS 

To perform a more thorough search there are two search functions available to use in CRL ProjectWise 
Search Form and Search Builder. See Figure 4-g. 

 

 

Figure 4-g Search Form and Search Builder 
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Selecting Search Form brings up Search by Form dialog box, which has the same look as the document 
properties window.  
 

 

Figure 4-h Select Search Definition Dialog. 

 

Figure 4-i Search by Form 

 

The tabs at the top of the dialog box break down the search criteria. The following tabs are recommended 
for searching: 

The General Tab lists document, file and folder information – you can use Wildcards to refine your search. 
There are drop down fields and buttons, which enable you to specify date ranges and criteria for the 
document or file. The folder area allows you to define what location you would like to perform your search 
in.  

The Attributes and More Attributes tabs display the CRL ECMS specific metadata. This can include both 
project and document properties. 

The Full Text tab lets you specify terms contained within document contents that need to be included in the 
search. 

If required you can save your search, you should do this now before you start the search.  
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When all the criteria have been set, select OK to display the search results. 

Selecting Search Builder brings up Define Search dialog box, which allows you to define multiple criteria 
based upon selected properties and attributes using expressions to limit the results.  

The Look for drop down list determines whether the search will look for Documents or Projects and Folders. 

If you Add Criteria (such as Document is created by ‘user name’) for your search, the criteria will be 
displayed in the middle window Find documents that match these criteria.  

The Define criteria area allows you to set values for certain properties that will be used in your search. The 
options will vary depending on whether Documents or Projects and Folders are chosen.  

Select the Criterion Type according to what you are searching for, then under Property and Value the 
options will change accordingly. Once the criteria and value have been set, click Add Criteria.  

You may then create another criterion set by going through the same process and clicking Add Criteria again. 
These additional criteria are seen as a string of statements connected by AND. You can remove any criteria 
by selecting it in the list and clicking the arrow next to Add Criteria and picking Remove Criteria. 

If required you can save your search, you should do this now before you start the search.  

When all the criteria have been set, select OK to display the search results.

 

Figure 4-j Select Search Definition Dialog 

 

Figure 4-k Define Search 
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5 Permissions in the CRL ECMS (ProjectWise) 

User access within the ECMS to the various folders, processes and functionalities in the CRL ECMS 
contract folders require that users are assigned the appropriate permissions. The User Management 
Tool is available through the CAD Services webpage ( ) to allow CAD 
representatives to assign and change permissions within the ECMS. In exceptional circumstances, CRL 
CAD services can assign users to permission groups as long as written permission from the appropriate 
Project Manager has been provided. 

 

5.1 CRL User Management tool 
The CRL User Management tool (accessed through  allows CAD 
Representatives to assign permissions to users within the CRL ECMS. See Figure 5-a. 

 

To be able to access the User Management Tool, a Citrix session must be running. Once a 
connection is established, use  to access the User 
Management Tool.  

 

Once the user has logged into CAD Services, the user is able to select ‘User Management Tool’ from the 
ribbon. The user will then have the option to select a user and assign or remove permissions where 
necessary. 

 

CAD Reps are able to assign or remove multiple permissions at one time.   

 

The User Management Tool is only useable by Project CAD reps. If you are not a CAD Rep, you 
will not be able to see this tool on the ribbon.  
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Figure 5-a User Management Tool 

1. Users can be 
filtered by Contract 
or by particular 
Contract 
membership groups 

 

2. Select user 
name from list 

 

3. Display list 
of current 
group 
membership 

 

7. Group 
summary of 
membership 
definition 

 
8. Messages 
summary of last 
action 

 

 

9.  Users are able to 
create a report 
(PDF/CSV) detailing user 
permissions and user 
groups (this is only 
available once a 
contract has been 
selected) 

 

4. Membership 
groups available to 
be assigned to users  

 

5. Once a group 
is selected, click 
to add to user’s 
membership 

 

6. Once a group is 
selected, click to 
remove to user’s 
membership 
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5.2 CRL ECMS User Groups 

User Groups in the CRL ECMS define within each workflow what actions a user can undertake at each state. CRL Contractor CAD representatives are responsible for 
assigning users to these groups. 

 

Table 5-1– User Groups 

User Group Definition Suggested Job Title / Role 

Cxxx - Editor Allows members to edit files in the Employer's ECMS at the Work in 
Progress workflow state. Initials appear as digital Signature in 'By' field. 

Draftsperson - Should be familiar with the CRL Approved CRL Drawing 
Packages 

Cxxx - Checker Enables user to push files from Engineering Content Check workflow state 
forwards. Initials appear as digital Signature in ‘Checker’ field 

Engineer/ Senior Engineer- responsible for checking the Design 
communicated by the CAD file. 

Cxxx - Coordinator Enables user to push files from Coordination workflow state forwards. 
Initials DO NOT appear as digital Signature. 

Senior Engineer / Package Manager - responsible for facilitating the 
sharing and inter discipline coordination of design data. 

Cxxx - Approver Engineering/Design lead responsible for the Package sign off. Initials 
appear as digital Signature in 'Approver' field. 

Senior Engineer / Package Manager etc. 

Cxxx - Reviewer Allows read only access to Cxxx CAD files at all stages of the chosen 
workflow. 

Any - Decided by Contractor 

Cxxx - Viewers A viewer can view documents once they have reached the ‘Coordination’ 
or ‘Interface Coordination’ workflow state 

Anyone on the project 

Cxxx - PDF Publishers A PDF Publisher can approve Final PDFs to be transferred by eB CAD Services 
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6 Third Party Data 

Third Party data in the CRL ECMS is data which is supplied to CRL by companies not contracted to follow CRL 
standards or procedures and is not assured for design purposes. Its usage may be restricted by the supplier 
to a specific ‘issued purpose’ which CRL are bound by.  

Most Third Parties make their data available as “for information”. CRL determines this to mean that data is: 

• Not verified or approved 
• Must not be used for any other purpose than viewing 
• Not editable 
• Shall not be copied 
• Shall not be misrepresented 
• Shall not be used out of context 

 

N.B. CRL does not accept liability for the content of Third Party or partner data in the CRL ECMS 
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7 Creating Documents in the CRL ECMS - Drawings, 2D/ 3D Models, 

          Coordination Models  
CAD files should only be created in the appropriate discipline folders based on the type of file created. The 
image below shows the folder structure for the disciplines within a Contract folder in the CRL ECMS.  

 

 

Figure 7-a CRL ECMS Discipline Folders 

 

For example, within the folders 1 – Reference Data and 2 – Application Data you may create Cells, 
Document Sets, Rebar DB Files etc within their relevant folder. 
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Within each discipline (From A – Architect to Y- Specialist Designer) the following will be displayed see Figure 
7-b. 

Under Drawing it is recommended to create drawings relevant to each folder, such as Elevations in the 
Elevation folder, see Figure 7-c. 

Under Model it is recommended to create models relevant to each folder, such as Coordination models in 
the Coordination folder, see Figure 7-d. 

Similarly, under Other you may use the folders to place relevant information, such as raster images in the 
Raster Image folder, see Figure 7-e. 

 

 

Figure 7-b Folders within each discipline 

 

Figure 7-c Drawing folder type 

 

Figure 7-d Model folder type 

 

Figure 7-e Other folder type 
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When drawings or models are moved from the state of Work in Progress to Engineering Content Check an 
additional folder will create automatically called CAD QA Reports, see Figure 7-f. 

Within this folder you will find HTML files in the form of a report for your drawing or model. The report 
details whether the drawing or model has passed CAD QA or whether it has failed CAD QA – and why it has 
failed. 

 

Further information about the CAD QA process can be found in Section 11. CAD QA inside the CRL 
ECMS within this document. 

 

 

 

 

 

 

Figure 7-f CAD QA reports folder 

Le
arn

ing
 Le

ga
cy

 D
oc

um
en

t



A Practical Guide- Creating Documents in the CRL ECMS- Drawings, 2D/3D Models, Coordination Models 

 

Page 19 of 63 

Document uncontrolled once printed.  All controlled documents are saved on the CRL Document System 

   © Crossrail Limited                                                                                     RESTRICTED                                                                                       
 

 

7.1 Creating Single Documents in the CRL ECMS 

Once you have selected the folder where you wish to create your drawing or model, the next stage is to 
create the file using the Document Creation Wizard. 

Select the New Document function from the toolbar menu Document > New > Document. The Select a 
Wizard dialog will be displayed: 

 

Figure 7-g Document creation wizard – select a wizard 

The Advanced Wizard must always be used and it is recommended to set this as the default.  

The ‘No Wizard’ option should not be used as this will cause the file to be created without the 
attributes required for the correct operation of the Title Block and Workflow functions. 

 

Figure 7-h Advanced wizard dialog 
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The Advanced Document Creation Wizard will appear. The wizard guides you through the creation of your 
document. 

 

  

Figure 7-i Select Target Folder 

 

Check Target Folder or change as desired. This is where your file will be created. 
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Figure 7-j Select a Template 

 

This section allows the user to select the CRL seed file template for their file. 

 

The CRL seed files should be used when creating files. The CRL Seed files can be found at the 
following path: Common Data/Seed Files/London Survey Grid/ 

 

Use ProjectWise document as a template – Any existing CRL ECMS file (including seed files) can be 
used as a template for the new document. Use the select button to browse the CRL ECMS 
datasource for the file to be used.  

Use external file as template – This option is not currently supported by CRL. 

Select from recently used templates – The CRL ECMS will retain the recent history of any files 
previously used as templates. Le
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Figure 7-k Define Document Code 

 

This section allows the user to create the drawing number for the file they are creating. 

 

About the fields: 

 

Programme Code – Pre-defined by the folder location and contract. 

Originator Code - Pre-defined by the folder location and contract. 

Type Code - Pre-defined by the folder location and contract. 

Asset Location code- User selects the appropriate location from the list. 

Sub-Location Code- User selects the appropriate location from the list based on the Asset Location 

                                  Code 

Level Code- User selects the appropriate location from the list. 

Serial No- This is a unique field auto-generated by the system but can be overridden by the user. 

Show Advanced Generate Options- Offers more choices when defining the Serial No. 
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This section allows the user to create the drawing number for the file they are creating. 

 

The fields in bold within the ‘Define Document Attributes’ dialog box are mandatory. You cannot 
continue if these are not filled in. 

 

When completing the Title, you could follow the below suggestions:  

Line 1 – ‘Where’ Location e.g. Tottenham Court Road Station 

Line 2 – ‘What’ Overall description e.g. Tottenham Court Road Stn Goslett Yard Worksite  

Line 3 – ‘What specifically’ Description detail e.g. Ground Level 

Line 4 – ‘Sheet Number’ e.g. Sheet 1 of 2 

 

Figure 7-l Define Document Attributes 

Le
arn

ing
 Le

ga
cy

 D
oc

um
en

t



A Practical Guide- Creating Documents in the CRL ECMS- Drawings, 2D/3D Models, Coordination Models 

 

Page 24 of 63 

Document uncontrolled once printed.  All controlled documents are saved on the CRL Document System 

   © Crossrail Limited                                                                                                                      RESTRICTED                                                                     
 

 

 

This information is populated when the drawing or model is moved up the workflow; See Section 10 for 
more information. 

 

Figure 7-m Define Secondary Document Attributes 
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Figure 7-n Document Properties 

 

Enter a Description for your drawing or model. Select an Application to specify the type of file – e.g. 
MicroStation, Bentley Building Architecture etc. 

 

The more detail you enter in the Description field, the easier it will be to find the specific drawing 
or model for yourself, your contract and other contracts when they are using your approved data.  
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Figure 7-o Create a Document 

 

Review the setup of your file. At this stage you can still go Back if you would like to make any changes. 
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Figure 7-p Completion 

Finish, your file will now be created in the target folder you selected at a version of P01.1 and a status of 
Unassigned, see Figure 7-q created drawing.  

 

Figure 7-q Created Drawing 
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7.2 Creating Multiple Documents 

To create multiple documents, select the folder you wish to create your multiple documents in: 

Document > New > Multiple Documents > - Enter the number of documents you wish to create and follow 
through the steps of the Advanced Document Creation Wizard. 

 

Figure 7-r Select Multiple Documents 

 

 

Figure 7-s Create Multiple Le
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8 Reinforcing Schedules – Upload to the CRL EDMS (eB) 

You must first approve the reinforcement drawing in the CRL ECMS to Shared; this creates an approved PDF 
of the drawing automatically, which is migrated to the CRL EDMS. A CRL EDMS record is automatically 
generated on migration of the approved PDF.  

 

Figure 8-a Overview of Reinforcement Schedule process 
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You must now reopen the shared drawing file as ‘Read Only’ and create separate PDFs for each sheet of the 
schedule table.  

• Open the relevant reinforcing drawing.  
• Place a Fence around an A4 Schedule Table, snapping to each corner of the A4 Frame.  

 

Figure 8-b Plotting to PDF of Schedules 

 

• Select Print from the Crossrail Tools Menu 
• Within the Print Options pane, ensure the ‘Plot Area’ is set to ‘Fence’ ‘Paper Size’ to A4 
• Select Print and save in a relevant folder. (N.B. As each Schedule Table will need to have its 

own A4 Page 
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Once you have finished exporting all of the schedule table pages as individual A4 PDFs, they should then be 
combined into a single PDF (ensuring they are in the correct order), which will then be uploaded into the CRL 
EDMS using its own disctinct number. See Figure 8-c. 

 

Figure 8-c Combined Schedule Tables PDF 

 

A Document Controller will now need to create a CRL EDMS record for the Combined Schedule Tables PDF. 
The below example shows how this may be done: 

In the CRL EDMS select Add Document 

Select Document Template – TSC-CRL – Schedule 

Construct the Document Number in relation to the drawing, e.g. using the relevant location etc. - see Figure 
8-e. 

 

Figure 8-d Create CRL EDMS Document 
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When created drag the Combined Schedule Tables PDF into the CRL EDMS record, see Figure 8-e Add 
Document to CRL EDMS record icon. 

 

 

Figure 8-e Add Document to CRL EDMS record icon 

 

You will now need to create a document relationship between the the original reinforcement drawing CRL 
EDMS record and the TSC-CRL – Schedule CRL EDMS record. 
 

Open the CRL EDMS and browse the original reinforcement drawing number. 

 
Under Document Relationships > click Add > Reference To > search for the TSC-CRL – Schedule CRL EDMS 
record and select Relate. 

 
The reinforcement drawing should now have the accompanying schedule tables attached as a Document 
Relationship. 
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9 Creating a Document Set in the CRL ECMS 

A Document Set is used to group together CRL ECMS documents into a single container but with no physical 
connection to each other. Any files within the Set are stored as a ‘shortcut’ to the original and continue to remain in 
their original locations. 

Figure 9-a shows how a Document Set looks in the CRL ECMS. 

[TIP: CAD Services require a Document Set for amendments of 5 or more drawings.] 

 
 

Figure 9-a Created Document Set 

 

To create a Document Set: 

• Navigate to the appropriate CRL ECMS Folder 

Document Sets must be stored in the Contract folder: 

 CXXX\ 2 – Application data\Document Sets\ 

• Create new Set 

Use the Document > Set > New function to create a Set, enter a name and description to identify its intended 
contents. 

If the Document Set is being created to support the submission of drawings and models via an RIR then it 
is good practice to set the name of the Document Set as the RIR Number and Revision. 
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Figure 9-b Select New Document Set 

 

Figure 9-c Create document set 

Add files to the Set 

Drag documents from the CRL ECMS into the newly created Set window.  
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Documents can be removed from the Document Set by using the Document > Set > Remove from Set 
function. If all documents are removed, the Document Set will disappear completely. 

 

Selecting Always Use Active Version will ensure the current version is always present in the Document Set, even if 
the document is revised. If you would like to ensure the document doesn’t update to the current revision in the 
Document Set, un-tick this box. See Figure 9-d. 

 

 

 

 

Figure 9-d Always Use Active Version 
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10 Superseding or Cancelling CAD Drawings and Models in the CRL ECMS 

Requests for superseding or the cancellation of drawings or models can only be made by a CAD Representative and 
in the case of Approved drawings or models, prior approval is required from the PM or PE for the relevant contract. 

 

There can be a variety of reasons why a file is no longer required. For example, a plan for work is no 
longer required due to cancellation of programme activity. This action should be clearly stated in the 
metadata or the watermark. 

It is important to highlight that a drawing or model has been superseded or cancelled to ensure the file 
cannot be modified. 

 

To Cancel or Supersede a CRL ECMS drawing or model file: 

• Document is deemed Superseded or Cancelled by document owner 

• Contract CAD Representative notifies Crossrail CAD Services by email 

  with details of the documents to be Superseded or Cancelled. A request for a 
document to be superseded requires the corresponding superseding documents (preferably as a ProjectWise URL 
link). The email request must contain full CRL ECMS document numbers and revisions (preferably as a ProjectWise 
URL link). 

Approved drawings or models require prior approval from the PM or PE for the relevant contract. 

• Once CAD Services have actioned the request, the file will become locked to prevent further editing or 
revision and the icon will be changed to identify the file as withdrawn.  

 

Figure 10-a Locked file icon 

 

• The PDF will be automatically generated and watermarked and will be created in the appropriate sub-folder 
of the PDF Withdrawn CRL ECMS folder 

• CAD Services will contact the CRL Document Controller with details of the PDFs to be replaced and marked 
as superseded or cancelled in eB 

• The CRL Document Controller will replace the PDF and metadata in eB in accordance with CR-XRL-Z3-GUI-
CR001-50164 

• The CRL Document Controller will notify CAD Services and the relevant contract by email that the process 
has been completed. CAD Services will remove the PDFs from the CRL ECMS 
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              Figure 10-b Cancelling a document 
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       Figure 10-c Superseding a document 
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Figure 10-d Document becomes Cancelled 

 

Figure 10-e Document becomes Superseded 
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Figure 10-f Suitability becomes Cancelled 

 

Figure 10-g Reference status becomes Unapproved Le
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Figure 10-h Document is Superseded by 

 

 

Figure 10-i Drawing is marked as cancelled in drawing border 

 

 

 
Figure 10-j Drawing is marked as Superseded in drawing border 
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11 Deleting documents in the CRL ECMS 

Before CRL CAD Services may delete a file from the CRL ECMS they must consider whether the request 
meets a number of criteria first. These criteria are described in Figure 11-a. For further details please contact 
CRL CAD Services. 

Requests for deletions can only be made by the listed Engineering Manager and/or CAD 
Representative stated within the document. 

 
 

Figure 11-a Deleting document flowchart 
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12 CRL ECMS Workflows 

Workflows in the CRL ECMS are a progression of sequential steps or states through which CAD data must 
pass in order to progress from initiation to completion.  

Each workflow state may require a manual or automated action to be completed before progression to the 
next is permitted. Through this method CRL assurance and other required checking processes may be 
enforced on data where required, before it is released to a wider audience. 

The main workflows in the CRL ECMS are all related to CAD data types. 

For example: 

Drawings Applied to all CAD drawing files 

Models Applied to all CAD model files (2D & 3D) containing live graphics 

Coordination Applied to all coordination and master model files 

 

Workflows differ because the data held within the CRL ECMS serves different purposes; therefore permission 
to access it varies. The differences are expressed through the order of Workflow States (the stages of a 
workflow), this in turn affects the additional metadata information about the file and the users assigned 
role. Please see Figure 5-a and Table 5.1 for more information regarding the CRL ECMS permissions and 
roles. 

Figure 12-a Model Workflow has three Workflow States, Work In Progress and Shared. The file is created, 
and developed fully inside the CRL ECMS. 

Figure 12-b Coordination Workflow has two Workflow States, Work In Progress and Shared. The file is 
created, and developed fully inside the CRL ECMS. 

Figure 12-c Drawing Workflow has two Workflow States, Work In Progress, Shared and Published. The file is 
created, and developed fully inside the CRL ECMS. 
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 Figure 12-a Model Workflow 
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Figure 12-b Coordination Workflow 
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 Figure 12-c Drawing Workflow 
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13 CAD QA inside the CRL ECMS 

The CRL ECMS CAD QA is performed when a drawing, 2D/3D model or coordination model is moved up the 
Workflow from Work in Progress to Engineering Content Check. Multiple drawings or models can be moved at the 
same time by selecting them, then right clicking and selecting Change State and Approve.  

 

You will then be prompted to accept or decline the following dialogue box: 

 

 

Figure 13-a Approve drawing for Engineering Content Check to start CAD QA 

 

The State for the drawing, 2D/3D model or coordination model will become RUNNING CAD QA whilst the CRL ECMS 
runs the CAD QA for the drawing/ model. 

 

If the drawing, 2D/3D model or coordination model successfully passes the CAD QA the State will become 
Engineering Content Check if it fails it will revert back to Work in Progress. 

 

A HTML will be created on the completion of the CAD QA. The HTML is stored under the CAD QA Reports folder, 
which is a sub folder of where the drawing, 2D/3D model or coordination model resides. 

Passing CAD QA does not confirm that the CAD Data is necessarily fully compliant with the CRL CAD 
Standard. 
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13.1 Guide to the CAD QA Rules 

A number of rules are checked against during the CAD QA. The next three pages provide information on what the 
CAD QA is checking against for Drawings, 2D/ 3D Models and Coordination Models. 

Table 13-1– Drawings QA Checks 

QA Check Notes 

ProjectWise Tag Set Check Seed file CRL ECMS Tag set must not be changed. 

Filename Check The filename must match the drawing number. 

Single Sheet Model check Only 1 sheet model should exist in design file. 

Reference Files Displayed Check All reference files must be displayed. 

Reference Files Nest Depth Check Reference files using Live Nesting must have a nest depth setting of 1. 

Valid Level Name Check All level names/ numbers must be approved. 

All Levels On Check All active file levels must be displayed ON, except for Watermark level. 

No Elements Check All design models (except Title Block) must not contain live elements. 

Active View Check View 1 in the sheet model must be open and active. 

View Attributes Check - Constructions View attribute should be OFF  

View Attributes Check - Dimensions View attribute should be ON  

View Attributes Check - Fast Cells View attribute should be OFF 

View Attributes Check - Fast Curves View attribute should be OFF 

View Attributes Check - Fill View attribute should be ON 

View Attributes Check - Level 
Overrides 

View attribute should be ON 

View Attributes Check - Line Styles View attribute should be ON 

View Attributes Check - Line Weights View attribute should be ON 

View Attributes Check - Patterns View attribute should be ON 

View Attributes Check - Tags View attribute should be ON 

View Attributes Check - Text View attribute should be ON 

View Attributes Check - Text Nodes View attribute should be OFF 

View Attributes Check - Data Fields It is advised that this view attribute should be OFF 

Global Origin Check Seed file global origin must not be changed. 

Working Units Check Seed file working units must not be changed. 

Resolution Check Seed file resolution must not be changed. 
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Table 13-2–Models QA Checks 

QA Check Notes 

ProjectWise Tag Set Check Seed file CRL ECMS Tag set (called Title Block) must not be changed. 

Filename Check The filename must match the drawing number. 

Sheet Model check No sheet models should exist in the design file. 

Reference Files Displayed Check Reference files must NOT be displayed. 

Reference Files Nest Depth Check Reference files using Live Nesting must have a nest depth setting of 1. 

Valid Level Name Check All level names/ numbers must be approved. 

All Levels On Check All active file levels must be displayed ON, except for Watermark level. 

View Attributes Check - Fill View attribute should be ON 

View Attributes Check - Line Styles View attribute should be ON 

View Attributes Check - Line Weights View attribute should be ON 

View Attributes Check - Patterns View attribute should be ON 

View Attributes Check - Tags View attribute should be ON 

View Attributes Check - Text View attribute should be ON 

Active View Check It is advised View 1 in the design model should be open and active. 

View Attributes Check - Constructions It is advised this attribute should be OFF. 

View Attributes Check - Fast Cells It is advised this attribute should be OFF. 

View Attributes Check - Fast Curves It is advised this attribute should be OFF. 

Global Origin Check Seed file global origin must not be changed. 

Working Units Check Seed file working units must not be changed. 

Resolution Check Seed file resolution must not be changed. 
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Table 13-3– Coordination Models QA Checks 

QA Check Notes 

ProjectWise Tag Set Check Seed file CRL ECMS Tag set (called Title Block) must not be changed. 

Filename Check The filename must match the drawing number. 

Sheet Model check No sheet models should exist in the design file. 

Reference Files Displayed Check Reference files MUST be displayed. 

Reference Files Nest Depth Check Reference files using Live Nesting must have a nest depth setting of 1. 

Valid Level Name Check All level names/ numbers must be approved. 

All Levels On Check All active file levels must be displayed ON, except for Watermark 
level. 

No Elements Check All design models (except Title Block) must not contain live elements. 

View Attributes Check - Fill View attribute should be ON 

View Attributes Check - Line Styles View attribute should be ON 

View Attributes Check - Line Weights View attribute should be ON 

View Attributes Check - Patterns View attribute should be ON 

View Attributes Check - Tags View attribute should be ON 

View Attributes Check - Text View attribute should be ON 

Active View Check It is advised View 1 in the design model should be open and active. 

View Attributes Check - Constructions It is advised this attribute should be OFF. 

View Attributes Check - Fast Cells It is advised this attribute should be OFF. 

View Attributes Check - Fast Curves It is advised this attribute should be OFF. 

Global Origin Check Seed file global origin must not be changed. 

Working Units Check Seed file working units must not be changed. 

Resolution Check Seed file resolution must not be changed. 

 

 

 

 

 

 

 

Le
arn

ing
 Le

ga
cy

 D
oc

um
en

t



A Practical Guide- Microstation Standalone CAD QA 

 

Page 51 of 63 

Document uncontrolled once printed.  All controlled documents are saved on the CRL Document System 

   © Crossrail Limited                                                                                     RESTRICTED                                                                                       
 

 

14 MicroStation Standalone CAD QA 

The standalone CAD QA is a piece of customised CRL software provided as an aid to allow users to test their data 
before moving it through the workflow. 

The standalone CAD QA is installed to your local PC, there is no means for automatic update therefore it 
may not be as up to date as the CRL ECMS CAD QA. 

Passing CAD QA does not confirm that the CAD Data is necessarily fully compliant with the CRL CAD 
Standard. 

Please refer to the IT Representative Handbook for information on installing the MicroStation 
Standalone CAD QA on your computer. 

 

Figure 14-a Microstation standalone CAD QA 
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The user has the option to run: 
• a CAD QA check on a Drawing (to check the integrity of the drawing file including borders and text etc…) 
• a 2D/3D Model check (to check the integrity of the model file etc…) 
• a Coordination Model check (to check the integrity of the coordination model file etc…)  
• or a Level Name Check (to ensure only levels within the CRL seed file are being used. See Figure 14-b 

 

The aim of this tool is to assist the file in passing the CAD QA when being pushed through the CRL ECMS workflow. 

Click OK to run the CAD QA. 

 

Figure 14-b CAD QA available rule sets option 

 

 An HTML should appear whether the drawing, 2D/3D model or coordination model passes or fails, see Figure 14-c. 

 

Figure 14-c HTML CAD QA report- Passed 
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The Summary notifies the user whether the drawing, 2D/3D model or coordination model has passed the CAD QA or 
not. 

If a drawing, 2D/3D model or coordination model fails the CAD QA, the reason will be displayed in the 
Summary. 

 

Figure 14-d HTML CAD QA report- Failed 

 

Drawings, models and coordination models must pass the mandatory checks to successfully complete the 
CAD QA. 
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15 Publishing documents in the CRL ECMS 

This diagram shows the process of requesting that files are published through CRL CAD Services. 

 
Figure 15-a Request for Publishing flowchart 
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16      Additional Resources 

Below are some additional references to help learn more about Bentley Systems and related technologies. 

 

16.1 Crossrail-Bentley Information Academy (CBIA) 

Crossrail and Bentley Systems have collaborated on the creation of a dedicated Academy to provide hands-on 
introductory sessions to the Crossrail supply chain. This includes current and future technology and software being 
used to design the digital railway. 

The Academy, located in Bentley Systems’ offices in Gracechurch Street, offers a curriculum particular to the current 
Crossrail system configuration. The introductory sessions on offer are designed to benefit the construction industry 
by driving forwards standards of design innovation. 

 

Figure 16-a Crossrail Bentley Academy 
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16.2 Bentley Learn Server 

The Bentley Learn server is an online training tool which allows users to participate in interactive tutorials. Training 
comes in the form of online Streaming Videos, Exams or Real-Time Lectures. 

Training is free with login access obtained for anyone who attends the Crossrail Bentley Academy BIM Awareness 
Session (See section 16 for more details). Once registered, users have the opportunity to access a wide range of 
training material based on their targeted learning path. 

Once access to Bentley Learn has been granted users will need to visit the following link to login 
https://ims.bentley.com see Figure 16-b. 

 

Figure 16-b Bentley Sign- in 
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17 Contacts 

17.1 Contacting CAD Services  

Normal business hours: 

Crossrail CAD Services are available via the following methods: 

By email -  

By phone -  

 

17.2 Contacting the Crossrail IT Service Desk 

Alternatively if you have a general technical inquiry, you can contact the Crossrail IT Service Desk, via the following 
methods: 

By email -  

By phone -  

 

All support calls will join a queue and be responded to in turn. 
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18 Glossary 

CAD Computer Aided Design and/or Draughting. 

CAD Data  
All electronic files and associated resources that make up the 
content within and the output from, the CAD Drawings, CAD 
Models and CAD Object.  

CAD Drawing 

A type of CAD Data file that is held within ECMS comprising 
content and one or more reference files. It is a representation of a 
Drawing and is saved and stored in a manner that allows 
reproduction of that Drawing. 

CAD Model 

A type of CAD Data file that is held within ECMS and comprising 
content and other source files held within ECMS. This file is 
typically two dimensional (2D) when it is a reference file to a CAD 
Drawing. This file is typically three dimensional (3D) when it is used 
as a source file to a 2D CAD Model. 

CAD Object Orientated Model 

A type of CAD Model where the CAD Data file contains discipline 
specific building and construction components and systems, 
and/or objects that have attributes and relationships to other 
objects. This file is typically produced by a discipline specific CAD 
Object Orientated Modelling software application. 

CAD QA CAD Quality Assurance 

CAD Standard The Employer’s document (CR-STD-005) that sets out the 
requirements for CAD Data held within ECMS. 

CRL Crossrail Limited 

Design Data 

All drawings, reports, documents, plans, software, formulae, 
calculations, method statements and other data whatsoever in any 
medium prepared by the Employer or the Contractor relating to 
the design and construction of the Relevant Works 

Document Set 
A ProjectWise container which is populated with Drawing and 
Models. Used to group Drawings and Models together for a 
purpose, for example to Issue for Authorisation. 

eB The Employer’s electronic document management system (EDMS).  

Electronic CAD Management 
System (ECMS) 

The Employer’s collaborative system used for the integrated 
management and production, of all CAD Data. This system 
facilitates the design review of CAD Data by the Employer and 
automatically transfers Drawings into EDMS. 

EDMS Electronic Document Management System 

IM Information Maintainer 
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London Survey Grid Crossrail Standard CR-STD-010 – London Survey Grid 

Master Model 

CAD Model that is three dimensional which: 

Reflects the current issue of all drawings for each part of the works 
for which the Contractor is responsible for design. 

Contains one design discipline CAD Model per discipline which in 
turn contains all CAD Models for that discipline. 

Does not contain live design data but only references to other CAD 
Models including those that contain geospatial or survey data. 

ProjectWise The Employer’s electronic CAD data and model management 
system. 

QRG Quick Reference Guide 

RIR Register and Issue Record 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Le
arn

ing
 Le

ga
cy

 D
oc

um
en

t



A Practical Guide- Table of Figures                             

 

Page 60 of 63 

Document uncontrolled once printed.  All controlled documents are saved on the CRL Document System 

   © Crossrail Limited  RESTRICTED 

 

19 Table of Figures 

Figure 3-a ProjectWise Explorer Datasources ................................................................................................... 3 

Figure 3-b ProjectWise Explorer Log in .............................................................................................................. 4 

Figure 3-c Directory creation confirm dialog ..................................................................................................... 4 

Figure 4-a CRL ProjectWise Explorer Window ................................................................................................... 5 

Figure 4-b View menus ...................................................................................................................................... 6 

Figure 4-c Quick Search Toolbar ........................................................................................................................ 7 

Figure 4-d Settings – Show all versions dialog ................................................................................................... 7 

Figure 4-e  Quick Search Toolbar settings ......................................................................................................... 8 

Figure 4-f  Quick Search settings dialog ............................................................................................................. 8 

Figure 4-g Search Form and Search Builder ....................................................................................................... 9 

Figure 4-h Select Search Definition Dialog....................................................................................................... 10 

Figure 4-i Search by Form ................................................................................................................................ 10 

Figure 4-j Select Search Definition Dialog ........................................................................................................ 11 

Figure 4-k Define Search .................................................................................................................................. 11 

Figure 5-a User Management Tool .................................................................................................................. 13 

Figure 7-a CRL ECMS Discipline Folders ........................................................................................................... 16 

Figure 7-b Folders within each discipline ........................................................................................................ 17 

Figure 7-c Drawing folder type ........................................................................................................................ 17 

Figure 7-d Model folder type ........................................................................................................................... 17 

Figure 7-e Other folder type ............................................................................................................................ 17 

Figure 7-f CAD QA reports folder ..................................................................................................................... 18 

Figure 7-g Document creation wizard – select a wizard .................................................................................. 19 

Figure 7-h Advanced wizard dialog .................................................................................................................. 19 

Figure 7-i Select Target Folder ......................................................................................................................... 20 

Figure 7-j Select a Template ............................................................................................................................ 21 

Figure 7-k Define Document Code ................................................................................................................... 22 

Le
arn

ing
 Le

ga
cy

 D
oc

um
en

t



A Practical Guide- Table of Figures 

 

Page 61 of 63 

Document uncontrolled once printed.  All controlled documents are saved on the CRL Document System 

   © Crossrail Limited                                                                                     RESTRICTED                                                                                       
 

 

Figure 7-l Define Document Attributes............................................................................................................ 23 

Figure 7-m Define Secondary Document Attributes ....................................................................................... 24 

Figure 7-n Document Properties ..................................................................................................................... 25 

Figure 7-o Create a Document ......................................................................................................................... 26 

Figure 7-p Completion ..................................................................................................................................... 27 

Figure 7-q Created Drawing ............................................................................................................................. 27 

Figure 7-r Select Multiple Documents ............................................................................................................. 28 

Figure 7-s Create Multiple ............................................................................................................................... 28 

Figure 8-a Overview of Reinforcement Schedule process ............................................................................... 29 

Figure 8-b Plotting to PDF of Schedules .......................................................................................................... 30 

Figure 8-c Combined Schedule Tables PDF ...................................................................................................... 31 

Figure 8-d Create CRL EDMS Document .......................................................................................................... 31 

Figure 8-e Add Document to CRL EDMS record icon ....................................................................................... 32 

Figure 9-a Created Document Set .................................................................................................................... 33 

Figure 9-b Select New Document Set .............................................................................................................. 34 

Figure 9-c Create document set....................................................................................................................... 34 

Figure 9-d Always Use Active Version .............................................................................................................. 35 

Figure 10-a Locked file icon ............................................................................................................................. 36 

Figure 10-b Cancelling a document ................................................................................................................. 37 

Figure 10-c Superseding a document .............................................................................................................. 38 

Figure 10-d Document becomes Cancelled ..................................................................................................... 39 

Figure 10-e Document becomes Superseded .................................................................................................. 39 

Figure 10-f Suitability becomes Cancelled ....................................................................................................... 40 

Figure 10-g Reference status becomes Unapproved....................................................................................... 40 

Figure 10-h Document is Superseded by ......................................................................................................... 41 

Figure 10-i Drawing is marked as cancelled in drawing border....................................................................... 41 

Le
arn

ing
 Le

ga
cy

 D
oc

um
en

t



 A Practical Guide- Table of Figures                             

 

Page 62 of 63 

Document uncontrolled once printed.  All controlled documents are saved on the CRL Document System 

   © Crossrail Limited                                                                                                                      RESTRICTED                                                                     
 

Figure 10-j Drawing is marked as Superseded in drawing border ................................................................... 41 

Figure 11-a Deleting document flowchart ....................................................................................................... 42 

 Figure 12-a Model Workflow .......................................................................................................................... 44 

Figure 12-b Coordination Workflow ................................................................................................................ 45 

 Figure 12-c Drawing Workflow ....................................................................................................................... 46 

Figure 13-a Approve drawing for Engineering Content Check to start CAD QA ............................................. 47 

Figure 14-a Microstation standalone CAD QA ................................................................................................. 51 

Figure 14-b CAD QA available rule sets option ................................................................................................ 52 

Figure 14-c HTML CAD QA report- Passed ....................................................................................................... 52 

Figure 14-d HTML CAD QA report- Failed ........................................................................................................ 53 

Figure 15-a Request for Publishing flowchart ................................................................................................. 54 

Figure 16-a Crossrail Bentley Academy ........................................................................................................... 55 

Figure 16-b Bentley Sign- in ............................................................................................................................. 56 
 

 

 

 

 

 

 

 

Le
arn

ing
 Le

ga
cy

 D
oc

um
en

t



A Practical Guide- Table of Tables      

 

Page 63 of 63 

Document uncontrolled once printed.  All controlled documents are saved on the CRL Document System 

   © Crossrail Limited  RESTRICTED 

 

20 Table of Tables 

Table 5-1– User Groups 14 

Table 13-1– Drawings QA Checks 48 

Table 13-2–Models QA Checks 49 

Table 13-3– Coordination Models QA Checks 50 

 

Le
arn

ing
 Le

ga
cy

 D
oc

um
en

t



Le
arn

ing
 Le

ga
cy

 D
oc

um
en

t


	1 Foreword
	Relationships with other Documents:
	1.1 Use of this Document:
	1.2 Presentation Conventions:
	This document has been written as addressed to the user.


	2 Scope
	2.1 General Information

	3 Access to the CRL ECMS
	3.1 Accessing CRL ECMS 
	3.2 Logging in to CRL ECMS

	4 CRL ECMS Client Software (CRL ProjectWise Explorer)
	4.1 CRL ProjectWise Explorer window
	4.2 Viewing Models & Drawings – Toolbars
	4.3 Quick Search in the CRL ECMS
	4.4 Advanced Searching in the CRL ECMS

	5 Permissions in the CRL ECMS (ProjectWise)
	CRL User Management tool
	5.2 CRL ECMS User Groups

	6 Third Party Data
	7.1 Creating Single Documents in the CRL ECMS
	7.2 Creating Multiple Documents

	8 Reinforcing Schedules – Upload to the CRL EDMS (eB)
	9 Creating a Document Set in the CRL ECMS
	10 Superseding or Cancelling CAD Drawings and Models in the CRL ECMS
	11 Deleting documents in the CRL ECMS
	12 CRL ECMS Workflows
	13 CAD QA inside the CRL ECMS
	13.1 Guide to the CAD QA Rules

	14 MicroStation Standalone CAD QA
	15 Publishing documents in the CRL ECMS
	16      Additional Resources
	16.1 Crossrail-Bentley Information Academy (CBIA)
	17 Contacts
	17.1 Contacting CAD Services 
	17.2 Contacting the Crossrail IT Service Desk
	18 Glossary
	19 Table of Figures
	20 Table of TablesTable 
	Blank Page



